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The DGNconform Menu

The DGNconform Menu is loaded on to the MicroStation menu as soon as DGNconform Server is loaded. This menu is built dynamically from the ASCII text file “DGNCONFORM.MENU” located in the same directory as the “DGNCONFORM.MA” file. The default menu supplied with DGNconform

Server contains the following options:

· Log In…

· Log Out

· DGNconform Draft

· DGNconform Toolbox

·  About DGNconform…

· Help on DGNconform

· Exit DGNconform

Log In…

Logs in to the DGNconform Server database. Most of the DGNconform Server commands require the user to log into the database before doing anything else.

Log Out

Logs out of the database and closes all dialog boxes.

DGNconform Toolbox

Opens the DGNconform Toolbox.

About DGNconform…

Opens the “About” dialog box, which displays the version number of DGNconform, the license

information and the contact details.

Help on DGNconform

Opens the DGNconform Server online reference manual.

Exit DGNconform

Exits the DGNconform Server application.
The Toolbox Interface
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Figure 2: The DGNconform Server Toolbox





All of DGNconform Server’s tools are activated from the DGNconform Server toolbox. The toolbox opens automatically after the user has loaded the application and logged on to the database.

From left to right, the tools are:

· Connect to Database

· Manage Users

· Edit Feature Table

· Conform

· Generate Reports

· Drafting Menu

Note that the DGNconform Server Toolbox will have a different number of icons depending on the privileges of the person logging in. If the user does not have the “Edit Dictionary” privilege, then the “Edit Feature Table” icon will not be available. Similarly, the “Conform” and “Generate Reports” icons will only be available to users with these respective privileges. The following chapters list the purpose of every item on the user interface, in order of each tool (left to right) on the main toolbox.
[image: image4.png]


  Connecting to the database
                                                 [image: image5.png]DGNConform Server... x|
1 ok




The “Connect to Database” icon on the DGNconform Server toolbox allows the user to log on to a specific database as a specific user. Starting this command will open the DGNconform Server Login window. This window opens up automatically when the toolbox is initially opened, or the “Log In…” command is chosen from the DGNconform menu. This tool can be used after startup to either:

1) Log in as a different user.

2) Log in to a different ODBC Data Source.

If the user is logging in to the database for the first time then no users will be set in the User Manager and the login name and password will be ignored. It is presumed that the first person to log in to a database will be the administrator, and hence the “Manage Users” dialog box will automatically open. Once the User Manager has created the Users Table, the Login dialog box will again open so that the administrator can define which person in the User Table they are.
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The User Manager
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The User Manager allows the database administrator to define who can use DGNconform Server and which tools are available to them. The User Manager can be used to:

· [image: image1.png]


New users                                

· Delete users

· Set or modify user

passwords

· Set privileges

The privileges that can be

set for each user are:

· Administrator

· Edit Dictionary

· Conform

· Generate Reports

· Append to

Dictionary

· Lock Dictionary

· Lock Reports

· Certify
[image: image9.png]Figure 3: The User
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Dialog Items

Login

This is the unique name assigned to represent each user. This is analogous to the Windows login name, and a similar system can be used for DGNconform as is used for your corporate network.

Full Name

This is the users full name (first name, last name). It is used internally for Reporting.
Login Password, Confirm Password

Passwords are used to validate that the correct person is logged in to DGNconform Server with the appropriate privileges. Passwords are defined twice to protect the user from a typographical error being entered unknowingly. The password can be any number of alphanumeric characters, and should be kept private.

New

Adds a New User to the User Profile. By default, the new user will inherit the privileges of the currently selected user in the User Profile list box.

Delete

Deletes the currently selected user from the User Profile.

Privilege Options

Administrator

The administrator privilege allows the user full control over user privileges for DGNconform Server. There will usually only be a small number of administrators in any organization. The administrator is the only user who is allowed to edit the User Profiles. Users who do not have this privilege will only be allowed to change their own password, and all other options on the User Manager dialog box will be disabled. Additionally, an administrator can overwrite a report in the Report Generator, even if the report belongs to someone else.

Edit Dictionary

A user with the Edit Dictionary privilege can open the Feature Table Editor. This means that the user has full control over the CAD standards database. This privilege is effectively an administrator privilege, and should not be granted to many users. Users without this privilege will not see the Feature Table Editor icon on the DGNconform Server toolbox, even if they have the “Administrator” privilege (see above).

Conform

“Conform” allows the user to open the Feature Conform tool to fix invalid design files. If the user does not have this privilege, then the Conform icon will not be visible on the DGNconform Server toolbox.

Generate Reports

Allows the user to open the Report Generator. Users without this privilege will not see the Report Generator icon on their DGNconform Server toolbox.

Append To Dictionary

The “Append to Dictionary” privilege allows a user running the Conform tool to automatically add an unmatched feature to the current Feature Table. This privilege should be used sparingly and only usually at the beginning of a project, since it allows the user to circumvent the correction of invalid features.

Lock Dictionary
This allows the administrator to lock certain users into using a particular data source 

name. This can be useful if an organization has several different databases for different departments. A user who has this privilege will not be able to log in to any other database than the one defined by the Data Source text field to the right of this privilege.

Lock Reports

This allows the administrator to lock a particular user into using a specific database for report generation. Reports will automatically be stored in the database named in the Data Source text field to the right of this privilege. If this toggle is OFF, then the user can choose to write their reports to any database.

Certify

The Certify privilege is designed to allow some users the ability to certify valid design files as having been checked and approved by the user. During certification, certain levels are turned off and a Watermark stamp is placed in the design file to signify approval. Users who do not have this privilege can still generate reports, but not certify correct files.

Marker Cell

The Marker Cell defines the cell to search for during certification. This can be any cell in any cell library defined by the MicroStation configuration variable $(MS_CELLLIST). If the Marker Cell is found in a design file that passes certification, then the cell origin and scale will be read and used for placement of the certification stamp defined by “Watermark Cell” (see below).

Watermark Cell

The Watermark cell defines the cell to be placed during certification if the design file passes with no errors. The Watermark cell will replace the Marker Cell (see above) if it exists in the design file. If the Marker cell does not exist or can not be found, then the Watermark cell will not be placed unless there is already a valid Watermark cell found in the design file, in which case it will replace it. (See also “Watermarking”).
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   Conform
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Conform is the feature conformer. This tool allows the user to correct invalid feature symbology in the active design file. After launching the Conform tool, the Feature Table Manager opens to allow the user to select the desired Feature Table. If there is more than one Feature Table in the database, care must be taken that the correct Feature Table is selected for the current design file. If you wish to conform a design file to multiple Feature Tables, then hold down the control key <CTRL> and select each one individually. After selecting the Feature Tables, Conform will import the data from the tables, and the Conform dialog box will open. Conform will scan every element in the active design file to check if it has a matching feature in the loaded Feature Tables. 

Conform will only scan and correct elements in the active design file (the master file) and only on levels specified by the Level Map. Where a non-matching feature is

found, the scanning stops and the element is identified as an “Unknown Feature”. Unknown features can be ignored or changed to an existing feature in the Feature Table. Optionally, the feature can also be added to the Feature Table if it should be in the table.

Unknown features will be optionally identified by zooming the view or highlighting, flashing or selecting the element (depending on the Display Options). The user will then be presented with a sorted list of known features to change the feature to, with the best match at the top of the suggestion list box. Sorting the suggestion list can take a while for large Feature Tables (over 1000 entries). To abort the sorting of the Feature List, press the reset button (usually the right mouse button). The sort will only prioritize the best 50 matches, so rows after the fiftieth suggestion will not necessarily be in order of best match. Aborting the sort 50% of the way through will mean that only the first 25 entries in the suggestion list are prioritized.

When Conform has finished scanning the current design file, a summary of the number of conformed features is displayed, as well as the number of features ignored and added.

Conform can abort the scanning operation at any time by pressing the reset button. Conform can also verify Watermark cells to check if a design file has been modified since it was approved, and also query a watermark for information about who certified it, to what CAD standards and when it was approved.
Conform Dialog Items

Conform has the following options on the dialog box:
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Options Menu                                                

(See below)

Start

Begins scanning the design file.

Next

Finds the next invalid element, after an element is corrected. This allows the user to interrogate the changes made by Conform before continuing to process the rest of the design file.

Ignore

Ignores the current invalid element and continues scanning.

Ignore All

Ignores all instances of this unmatched feature until the end of the design file.

Change

Changes the symbology of the unmatched feature to match the symbology of the selected feature in the Feature Table.

Change All

Changes all features in the design file that match the current unknown feature to match the symbology of the selected feature in the feature table. Conform will then report how many changes were made to the design file, and then allow the scan to continue from where the scan left off.

Add

Adds the current unknown feature to the Feature Table. The Feature Table will then be exported to the database when the Conform dialog box is closed. The added feature will be allocated a default name based on its symbology, and placed in a group called “Added by UserName” where “UserName” is the full name of the user who is currently logged on. This feature can then be renamed and relocated using the Feature Table Editor after the Conform scan is complete.

Match

Match will select the feature in the suggestion list that matches an element selected by the user. This is useful when the unknown feature should be changed to a feature that is nearby in the design file.

Hide

Temporarily hides all elements in the design file that do not match the current unmatched element. This allows the user to quickly preview all of the elements that would be affected by a “Change All” or “Ignore All” command. It is also useful when the current element is obscured by other elements in close proximity. The hidden elements will reappear the next time the view is refreshed.
[image: image12.png]Tip: To see concurrent display of all elements in the design which are like the current unmatched
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Change To (List Box)

This list box summarizes all of the features in the Feature Table that are of the same type as the current unknown feature. This list is sorted in descending order of closest match in the Feature Table. Therefore, the top of the list will always be the most likely match for the unknown feature. The selected feature in this list box will represent the feature that the user wishes to change the unknown feature to. Information on this suggested feature is displayed below the list box in the “Group” and “Descr” text fields.

Group

The Group text field displays the table name and parent groups of the selected feature in the “Change To” list box. For example, a feature named “River” in a group named “Water Features” in a Feature Table called “Mapping” will have a group name: “Mapping.Water Features”. Each parent group is separated by a period.

Descr

The “Descr” text field summarizes the symbology of the feature currently selected in the “Change To” list box. For example, a river feature may have a description:

Linear: lv=23 co=5 wt=1 lc=0 Where the selected feature has a default name, the description will be exactly the same as the feature name.

Diff

Defines the “Difference” between the currently selected feature in the “Change To” list box, and the unmatched feature. Each mismatched property will be listed, for example:

Color (4), Level (7) means that the chosen feature differs from the unmatched feature because it has a color of four and is on level seven. Where the text size or line spacing is different, the size is displayed as a percentage scale representing the relative difference. For example, “Text Size (0.003%)” means that the text size is only slightly wrong – by a factor of only 0.00003.
Conform Menu Bar
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Conform has a menu bar with one sub-menu: “Options”. There are three menu items within the Options menu:

· Display

· Scan Criteria

· Read Watermark
Display

The Display menu item opens the Display Options dialog box. The display options affect the way an unknown feature is displayed by Conform. The options on this dialog are summarized below:

Highlight

[image: image27.png]Scan Cileria
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The unknown feature will be highlighted in the active view. The highlight color will be inherited from MicroStation’s active highlight color, defined by: “Settings > Design File > Color > Element Highlight Color”

Select

The unknown feature will be selected. Note that this may appear to have the same visual effect as the “Highlight” option if the following toggle button is ticked in the MicroStation User Preferences: “Workspace > Preferences > Input > Highlight Selected Elements”. Note also that the

existing selection set is cleared each time an unknown feature is selected. This makes it easy to use other MicroStation tools in conjunction with Conform, such as “Change Attributes” or “Delete Element”.

Flash

Flash will flash the element in the current highlight color with a frequency of approximately half a second. If the flash option does not appear to work reliably under MicroStation J, check the “DGNconform Server Installation Guide” for graphics card compatibility with this option.

Zoom

Zoom will modify the chosen view window (see below) extents to center around the unknown feature. If the zoom feature does not appear to work for some elements, it is because the calculated window extents are smaller than MicroStation allows.

Zoom Window

This option chooses the appropriate MicroStation view window (1 to 8) to perform the zoom function.

Zoom Factor

The Zoom Factor affects how close to the element the zoom window is to the unknown feature. It is sometimes convenient to have the zoom further out from the element to determine what the feature is supposed to be. The zoom factors (1 to 9) represent a logarithmic proportion of the ratio between the element size and the window extents, with one being the maximum zoom and nine being the minimum.
Scan Criteria

This menu option opens the Scan Criteria dialog box.
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                              Figure 7: The Scan Criteria Dialog Box
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Use Fence

If toggled ON, then Conform will only scan the active design file by the active fence. If no fence is defined when a Conform is started, then a warning dialog box will appear and the fence mode will be disabled. If Use Fence is OFF, then the entire design file will be scanned during a Conform.
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Fence Mode







The fence mode operates the same way as MicroStation fences. For most cases, the fence mode should be “inside” or “overlap.”

Scan Levels

Defines which levels to scan and which levels to ignore. The current level settings will be summarized by a text string to the right of the “Set Levels” button.

Set Levels
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Opens the Level Map. This dialog allows the user to specify which levels to search on. Levels turned off will be ignored. It is a good idea to always check the current Level Map settings before generating a report or running Conform.

  Figure 8: Setting the levels to
process in Conform.


Drawing Scale

The drawing scale settings define the scale factor for text and line spacing. The drawing scale will affect both the way Conform interprets a text feature, and the way it replaces an invalid text feature.

Apply Scale

Will apply the current drawing scale to all text features. If this toggle is OFF, then the scale will be unaltered, i.e. 1:1.

Scale

Represents the current scale factor for the active design file.

Match Threshold

The Match Threshold represents a tolerance to be used when using the “Change All” tool. If a text element does not exactly match the required size and the user chooses “Change All”, then Conform will look for other text elements with the same symbology that are within a given percentage of the text size for the replacement feature, and replace those as well. The given percentage is the number represented by the Match Threshold, and it is user definable. Match Threshold will also be used for calculating line spacing for text nodes.
Read Watermark

Read Watermark will allow the user to query an existing Watermark cell. After this tool is activated, the user can choose the Watermark cell to query, and accept it with a data point. The Watermark details are then displayed in the Watermark Info dialog box.

Watermark Cell


  

This is the name of the cell used for

Watermarking. This cell name may differ for people in different departments of the same organization.

Feature Table

Lists the Feature Tables used for

certifying the design file.

Stamped by User

Lists the full name of the user who           Figure 9: The Watermark Info Dialog Box
stamped the design file.

Date Stamped

Lists the time and date when the design file was stamped and certified.

Num Elements

Represents the number of elements that were scanned and verified as correct when the design file was certified.

Watermark Status

Represents the status of the watermark at the time DGNconform Server last checked the watermark – either VALID or INVALID. Note that if the design file has been modified since the last time the watermark was checked, then the Watermark Status might say “VALID”, even though it isn’t. The Verify Watermark tool can be used to ensure watermark integrity (see below).
Verify Watermark

This command scans the design file to ensure the file has not been modified since it was certified. If the file has been modified, then the watermark will automatically invalidate itself and a single red line will appear through the watermark cell.
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   The Report Generator
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The Report Generator has two purposes:

· Generating Reports

· Certifying Design Files
Generating Reports

The Report Generator is used to create reports on all of the elements in a list of design files that do or do not match any of the features in the chosen Feature Tables. The Report is generated as a database table, either in the DGNconform Server database, or in a separately chosen ODBC data source (as defined by the user). This database table can then be printed out, converted to a text file or other file format, or used to generate a customized report, by using a database application such as Microsoft Access or Oracle.

Several different report types can be generated for the chosen design files. They include:

    •   A Feature Summary

    •   An Error Summary

    •   A Detailed Report of Each Error

    •   A Watermark Report

Additionally, two compulsory reports are generated every time a report is produced:

    •   A Report Information Table

    •   A Design File Summary Table

Note that to overwrite an existing report, the user must be either:

a) An administrator, or

b) The creator of the report.

As with Conform, the Feature Tables must be chosen before a report can be generated. The chosen Feature Tabled define which features are allowed for each design file in the report. Once the Feature Tables are chosen and imported using the Feature Table Manager, the Report Generator dialog box will open. The Report Generator allows the user to process one or more design files for each report. Additionally, reference files for each design file can also be reported on automatically without the user having to select them. If reference files are processed, then the reference clipping boundaries defined in each master file will be observed such that only features within the reference clip boundary will be analyzed. Similarly, if the reference files have been moved and scaled, then the coordinates displayed in the Report Table will also be transformed by these settings. Report Generation can be aborted at any time by pressing the reset button (usually the right mouse button).
Certifying Design Files

The Report Generator also has a “Certify” command. This command allows the user to flag each file as being approved, as long as it passes through the report with no errors. Reports are generated by both the “Report” and the “Certify” commands. Certification involves two automatic procedures:

1. Watermarking

2. Turning off unused levels
Watermarking

If a design file passes certification, then DGNconform will attempt to place a Watermark cell in the design file. The watermark cell name is defined in the user’s profile, and must be a cell either found in the attached cell library, or in a library defined in the configuration variable “MS_CELLLIST”.

The first thing the DGNconform Server Administrator needs to do (if Watermarking is to be used) is to create a “Marker” and a “Watermark” cell. This can be done using the usual MicroStation methods for cell creation. An example of a marker and watermark cell is given below. The origin and scale of the placed watermark cell will be picked up from one of two existing cells in the design file: a marker cell, or a watermark cell. This means that in order to watermark a design file, the user has to first place a marker cell into the design file. This cell will usually be placed in the title block area of the design file. Additionally, the administrator should make sure that both the marker cell and the watermark cell symbology are defined in the Feature Tables; otherwise, the file cannot be certified.


Note: the watermark / marker cell is written to during a certify operation, therefore it needs to be in a write enabled design file. For this reason, the marker cell should be placed in each master design file, not a border reference file.


If a file passes a certify operation, then a fresh watermark will replace the existing Marker cell. If the design file already has an existing watermark, then this cell will also be replaced, but only if the “Update Existing Watermarks” toggle is ON in the Advanced Options dialog box. If this option is OFF, then existing watermarks will be ignored, and new watermarks will only be placed on top of marker cells. If a file does not pass certification, then the watermark will not be placed. Additionally, if a valid watermark already exists in the file, it will become invalidated. Invalidation of a watermark can occur during three possible operations:

1. The user generates a report.

2. The user performs a “certify”.

3. The user runs the “Verify Watermark” command on the Watermark Info dialog box.

A watermark will only be invalidated if one of the following occurs:

    •   An error occurs during a report or certify.

    •   The design file has been modified since it was last certified.

If an error occurs during the report or certify, then the error will be logged in both the
“Error Summary” and “All Errors” report. Additionally, if an existing watermark is invalidated, then the reason will be logged in the Watermark Report. Watermarks invalidated due to symbology errors will be represented by a cross over the watermark cell. Watermarks invalidated due to design file modification will be represented by a single diagonal line.
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Turning off Levels

The second part of the certification approval process is the automatic turning off of unwanted levels in each view in the design file. The levels to be turned off are defined in the administrator configuration file “dgnconform.cfg” by the variable “_DGNCONFORM_DISPLAY_LEVELS_OFF”. If no levels are defined by this variable, then this operation is effectively skipped.

Dialog Options

Design Files

            

Displays the chosen design

files to generate the report

on. This list can be edited

by clicking the “Add /

Remove” button. Master

design files are displayed in

black text; referenced

design files are displayed in

blue.

Set Levels

Defines the levels to scan

for each design file during a

Report or Certify.

Add/Remove

Allows the user to edit the

list of design files to

process.
Advanced

Opens the Advanced Options Dialog box (see below).

Report Name

The name of the report to generate. This combo box contains the names of all existing reports so that the user can overwrite an existing report or create a new one.

Feature Summary

Generates a report listing each unique feature and how many instances of each were found in every design file.

All Errors

Lists the symbology, coordinates and file position of every element that did not match any features in the Feature Tables. Note that this report can be very time consuming to produce in files with many errors.

Error Summary

Produces a summary of each error in the design file and how many times it occurred.

Watermarks

Lists the status of watermarks in every design file.

ODBC Data Source

The name of the ODBC data source to write the report to. By default, this will be the DGNconform Server database, but it can be set to any data source defined in the ODBC Data Sources in “Windows > Control Panel”. It may be quicker and easier for users to define their own report database to use locally, if reports are not required to be shared amongst users. This can also be useful to ensure that the DGNconform Server database does not get too large.

All / None

These buttons allow quick selection of design files in the list box. This can be convenient on large lists in conjunction with other commands, such as Remove, Find Refs or Set Levels.

Remove

Provides a quick way to remove the selected design files from the list box.

Find Refs

Finds all reference files for the selected design files. Nested reference files can be picked up by selecting the new reference files and then selecting “Find Refs” again.

Set Levels

Opens the Level Map dialog box. This allows certain levels to be turned on or off for each selected design file when generating the report.

Report

This button begins generation of the report. A completion bar will open to display the progress of the Report Generator for each design file (and reference file) in the design file list. Files that do not pass with zero errors will have their watermarks invalidated if they exist.
Certify

Begins certification of the design files. This process is identical to the Report command, but in addition it will:

•   Turn off specified levels in all views (see           “_DGNCONFORM_DISPLAY_LEVELS_OFF”).

    •   Place or update watermark cells if there are zero errors.

View Report

Opens the Report Viewer dialog box.
Menu Options

There are two menus on the Report Generator dialog box:

    •   File

    •   Edit





   
The File menu contains two items:

    •   Choose Files

    •   Find Refs

These options are analogous to the “Add/Remove” and “Find Refs” buttons on the dialog box.

The Edit Menu has the following options:


    •   Select

o  All

o  None

o  Invert

    •   Remove

    •   Set Levels

The “Invert” option inverts the current design file selection. The other options are synonymous with their command button counterparts.

Advanced Options

The following options are available on the Advanced Options dialog box:

Use Attachment Scale

If this toggle is ON, then text in reference files will be read scaled by the working units of the master file. This toggle should usually be ON.

Use Clip Boundary / Masks

If this toggle is ON, then clip boundaries and clip masks are observed when reporting on reference files. This means that only the portions of the reference file that are visible in the master file will be reported on.
Allow Duplicate Reference Files

This option should usually be used in conjunction to the “Use Clip Boundary / Masks” option. If you have many design files that reference different parts of the same file using clipping masks, then you may want the report to be able to scan that reference file multiple times. If this toggle is ON, then the “Find Refs” button will allow the same reference file to be added multiple times to the design file list. If it is OFF, then only unique file names will be allowed in the design file list.
Apply Scale

If turned ON, this toggle will scale text features by the Drawing Scale as defined by the standard border sheet scale. If no standard border sheets are attached, then the default scale is used.









Default Scale

This option defines the scale to use if no Drawing Scale could be read from the standard border sheets.

Update Existing Watermarks

If the user is certifying design files, this toggle will allow existing valid watermarks to be rewritten with the current time, date, user and feature tables. If this toggle is OFF, then existing valid watermarks will be left alone. If the file has no errors, then invalidated stamps will be updated to valid status.

Clip by Shape

This option allows the report to be clipped by a boundary shape element. The shape element must be a valid feature defined in one of the currently loaded feature tables.

Find

Starts the locate tool for defining the shape to be

used for clipping. To define a border shape, press the Find button, select the border shape and then accept it with a data point. The feature name of the shape will be shown in the “Feature” text label.
The Report Viewer

The Report Viewer allows a simple way for the user to view the contents of a report without resorting to opening the database from within a database application. This is particularly advantageous for users who do not have a database application loaded on their machine. The Report Viewer dialog and its columns are fully resizable, and have the following dialog options:
Report Type

Allows the user to choose which report to view.

SQL Query

Allows the user to enter an SQL query to create their own data sets. All standard ANSI SQL commands are supported, for example:

Example 1

SELECT Feature, Num_Features FROM Report_Fea_new2 ORDER BY Num_Features ASC

Will display only the “Feature” and “Num_Features” columns, sorted in order of most common features at the top.


Example 2

SELECT Xcoord, YCoord FROM Report_All_new2 WHERE Symbology LIKE ‘%lv=6%co=5%’

Will display the X and Y coordinates of all mismatching features on Level 6 that have a

color of 5.


For more information on SQL statements, consult an SQL manual or search on the Internet for: ANSI + SQL + TUTORIAL

Submit

Submits the current SQL Query. If the SQL query does not result in any database rows being returned, then the column display name will change to “SQL Query returned no rows”.
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Printing and Managing Reports
In order to print and manage your reports we have to open the database using Microsoft Access. The following steps will show you how to create a printable document and store that document in Falcon.

Open Microsoft Access by clicking on Start, then Programs, then Microsoft Access.
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When Access opens highlight More Files…, then click on the OK button.
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In the dialog box that opens, navigate to c:\documents, then highlight dgnconform.mdb, then click on the Open button.
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A dialog will open that will contain some templates as well as any reports that you may have created.
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When you run the report generator, it will create three reports as shown above. The Report_Dgn_conform report contains File Name, Levels scanned, Working Units, Global Origin, and Scale Factor. The Report_Inf_conform report contains No. of Reports run, Username, Action taken, Action date, Feature Table used, and No. of Errors. The Report_Sum_conform report contains Design File Name, Symbology Error, and No. of Errors.

As a general rule the Report_Sum_conform report will be the one that gets printed.

To print as well as save the report(s), right click on the report name, then left click on Export.
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In the dialog box that opens, navigate to your project directory (example: c:\documents\cfms_local\ppms#\dppms#), then at the bottom of the dialog box click on the choice list button in the Save as type field , scroll down and click on HTML Documents (*.html; *.htm), then click on the Save button.
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This file can now be printed and also added to Falcon for proper electronic file management. On the next page is an example of the printed report.
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